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Upgrade Procedures from Version 9 to Version 11 
Before this type of installation is performed the user must backup all the wells and logs in their 
database. The Hardware Key does have to be reprogrammed when a major upgrade is being 
performed. 

Export Log / Well Data 

This module allows you to export log configurations, well information and your Geology 
Dictionary. 

1.) Double click on the  Icon. Acknowledge the Security Information window by clicking on 

the  button. This will initiate the program and activate a Connect Database window. 

 
 

2.) Highlight the PGEOLOGY V9 Metric {Microsoft Access Driver)*.mdb)] database and enter your User 
ID and Password in their respective fields (your default User ID and Passwords are both "pgeology"). 

 

Note: If connecting to the imperial database, highlight the PGEOLOGY V9 Imperial {Microsoft Access 
Driver)*.mdb)] instead. 
 

3.) Click on the  button to complete the connection. The Open Log window will be shown.  

4.) Click on the  button. 
5.) Click on the File menu selection, select Import / Export and then select Export Log / Well from the 

sub-menu. Or, you can click on the  Export Log / Well button on the Toolbar. 

 

6.) Click on the  button. This will activate a system message. 
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7.) Click on the  button. This will activate a Choose Directory window. You may wish to 
create a new folder for these well. In the example an old wells folder is selected. 

 
8.) Click on the drive and directory where you wish the well data to be exported to. Click on the 

 button. This will activate the Exporting window. 

 
9.) When the export all well data is finished a System Message will be activated as shown below. Click on 

the  button. 

 

You will want to export your geological expansion dictionary if it has been customized. Click on the 

 button and designate a drive, folder and file name and then click on the  

button. Then click on the  button. 
 

You will want to export your symbols if they have been added to or customized. Click on the 

 button and designate a drive, folder and file name and then click on the  

button. Then click on the  button. 
 

You will want to export all your Generic Category Data for each one that you have created. Click on 

the  button and designate a drive, folder and file name and then click on the  

button. Then click on the  button. 
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Version 11 Download and Installation Procedures 

 
1.) Click on the Full Power*Suite Installation & 7 Day Demo from our downloads page 

www.powerlogger.com/downloads.htm. This will activate a Submit Personnel Information Page. 
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2.) Filled in the mandatory fields and click on the  button. This will activate 
the download file. 

 

3.) Click on the  button the file to a location that you can find. Maybe the desktop. 
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4.) This will activate another download window indicating download is complete. Click on the  
button or locate the file V11Setup.exe and double click on it. This will activate the self extractor. 

 

5.) Make sure the  is activate. Then Click on the  button. Then 
if the files exists Overwrite the existing files and then the windows installer should take over. This will 
activate a message when completed that all the files have been extracted to a folder in the C drive 
called C:\PSV10SETUP\. 

 

Power*Suite Installation Procedure 

6.) a.) This will activate the Install Shield setup followed by the Windows Install window and the 
Power*Suite Welcome Message Window. if your computer is running on XP or an older Operating 

System Click on the  button. 

 
6.) b.) If your computer is running on Microsoft Windows 7 or Microsoft Vista operating systems click 

on the  button. . Open up the C Drive in either my computer or windows explorer 
and locate the PSV11Setup folder and right click on the Setup.exe and select Run as Administrator. 
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This will again activate the Install Shield setup followed by the Windows Install window and the 

Power*Suite Welcome Message Window shown above. Click on the  button. 

 

7.) This will activate the License Agreement window. Click on the  beside I accept the terms in the 

license agreement. Then click on the  button. 
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8.) This will activate the Customer Information window with User Name and Organization fields. In the 
Install this application for portion of the window Click on the  beside Anyone who uses this 

computer. Then click on the  button. 

 

9.) This will activate the Destination Folder window with C:\POWERSUITE_V11 as the default location. 

Click on the  button. 

The User has the ability to change the destination folder if required by clicking on the 

 button. This is not recommended. 

 
10.) This will activate the Database Folder Location window with C:\POWERSUITE_V11\Database as 

the default location. Click on the  button. 
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The user has the ability to change the database destination folder by clicking on the  
button. This is recommended if you are working with a LAN system where the Network 
directory is being backed up on a regular basis. If not the default destination folder is 
recommended. 

 
11.) This will activate the Setup for Hasp Window. If you have a Hasp USB or parallel port key and it has 

been activated for Power*Suite Version 11 Click on the  button. If you do not have a 
hasp key and you are evaluating then Uncheck the  and then Click on 

the  button 

 

12.) This will activate the Ready to Install window. Click on the  button. 

 
13.) Next the user will see the Installing Power*Suite window copying files, writing to the registry, creating 

desktop icons, creating start menu folder, ODBC components etc. An example of this window can be 
seen below. 
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14.) This will activate the Sentinal HASP Run time Setup Welcome window. Click on the  
button. 

 
15.) This will activate the End User License Agreement for the Hasp Driver. Click on the radio button  

beside I accept the license agreement and then Click on the  button 
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16.) This will activate the Ready to Install window. Click on the  button. 

 
17.) This will initiate the install windows for the HASP device drivers. 

 
18.) When the installation is complete the program will activate the Finished window. Click on the 

 button 
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19.) This will activate the Power*Suite Update Welcome Message Window. Click on the  
button. 

 

20.) This will activate the License Agreement window. Click on the  button. 

 

21.) This will activate the Destination Folder window with C:\POWERSUITE_V11 as the default location. 

Click on the  button. 

The User has the ability to change the destination folder if required by clicking on the 

 button. This all depends on where the original Power*Suite was installed. 
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22.) This will activate the Ready to Install the Program window. Click on the  button. 
Next the user will see the Installing Power*Suite Update window copying files, removing backup 
files etc. An example of this window can be seen below 

   

23.) Once the Update Installation is complete the Install Wizard Completed window shown below will be 

activated. Click on the  buttons twice for the Update and the Main install.. 

     
You will now have successfully installed the Power*Suite Update. 
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HASP Key Log Upgrade Procedures 
The following are the instructions on how to update your HASP key, either a hardware key or USB key.  

 

We have adapted our authorization from Version 3.0 onward with a Hasp Hardware Key. Once a 
Power*Suite program is loaded on a machine the user has simply to attach a Hasp Hardware key to the 
Parallel Port on their computer. The program is initially installed and protected by a software program. We 
have utilized a Software Authorization Program called Crypkey. 
 

1. Click on the button on the toolbar and click on All Programs and select 
POWER*SUITE_V11. Then select the Hasp Update Tool selection, and then click on the 

 selection. This will activate the Hasp Key Activation window. 

 

2.  Click on the  button. This will activate the open file window and locate the 
codes that were sent to you via email or other means. If you do not have email then you will 
have to fill in this Code field by hand. 

 

3. Click on the button and the codes will then be viewed in the activation window 
as shown below. 
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4. Click on the  button. If done successful you will receive a system message as 
shown below. Or if unsuccessful you will receive a message such as tampering as shown 
below. 

     

5. Click on the  button to close the window. 
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Verify your USB Activation 

1.) Double click on the  Icon. Acknowledge the Security Information window by clicking on 

the  button. This will initiate the program and activate a Connect Database window. 

 
 

2.) Highlight the PGEOLOGY V11 Metric {Microsoft Access Driver)*.mdb)] database and enter your 
User ID and Password in their respective fields (your default User ID and Passwords are both 
"pgeology"). 

3.) Click on the  button to complete the connection. The New Log window will be shown.  

4.) Click on the  button. 
5.) Select Show Registration, under the Help menu selection in Power*Core as shown below. 

 
This will activate the Security Information window and show you the access flags on the USB key you just 
activated. The window is shown below. Yours should be the same as this one shown only different license #. 
If they are the same repeat these activation steps for all the USB hasp keys you were sent. 
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 Import your Log / Well Data 
6. Select Import / Export, under the File menu in Power*Log / Curve or Core, and then 

select Import Log / Well from the sub-menu. Or, you can use the  Import button on 
the Toolbar. This will activate the Import window shown below. 

 
 

Note: Import the symbols, generic category & geological expansion dictionary exports 
first. Then, import your well data. 

1.) Click on the  button to browse through your drives/directories for the file(s) you wish to 
import. Note that files available for importing will have an .EXP file extension. Any of the files that you 
select will then be added to the File list. Please make sure that the files you wish to import are 
highlighted (selected), in the list prior to importing. 

Note: You are not able to select more than six wells from the Import From window successfully. If you have 
a lot of wells to import, select the first well from this window. Go through the import procedures outlined 
below 7-12. Exit the import window. Activate the Import window again and the default folder will be the last 

one you used, and then you can click on the  button and proceed. 

2.) The Import Log/Well window will now display the details of the file(s) to be imported. Select or click 
(highlight) the file(s) to be imported.  

Note: Use the  button to select all of the files or use the   button to select none of the files. 
Note that you can select or turnoff individual files by simply clicking on them with your mouse. The 

 button will remove the selected/highlighted files from the import list, but will not delete them. 

The  button, on the other hand, will completely erase the selected/highlighted files from their 
directory. Once deleted, these files will no longer be recoverable. 
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4.) Click on the  button to activate the following system message, “Do you really want to 
IMPORT the highlighted files?”. 

5.) Click on the  button to proceed with the import. 

Note: If you clicked on the  button, and the file you are importing contains the information 
from an Entire Well, the following system message will be activated, “About to IMPORT ENTIRE WELL 
data. All information associated with this well in the database will be OVERWRITTEN. Continue?”. 

6.) Click on the  button. 

7.) Upon completion of the import, the following system message will then be activated, “Data has been 
imported successfully.” 

8.) Click on the  button to confirm the successful import of the data. 
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Import your Log / Well Data 
7. Select Import / Export, under the File menu in Power*Log / Curve or Core, and then 

select Import Log / Well from the sub-menu. Or, you can use the  Import button on 
the Toolbar. This will activate the Import window shown below. 

 
 

Note: Import the symbols, generic category & geological expansion dictionary exports 
first. Then, import your well data. 

3.) Click on the  button to browse through your drives/directories for the file(s) you wish to 
import. Note that files available for importing will have an .EXP file extension. Any of the files that you 
select will then be added to the File list. Please make sure that the files you wish to import are 
highlighted (selected), in the list prior to importing. 

Note: You are not able to select more than six wells from the Import From window successfully. If you have 
a lot of wells to import, select the first well from this window. Go through the import procedures outlined 
below 7-12. Exit the import window. Activate the Import window again and the default folder will be the last 

one you used, and then you can click on the  button and proceed. 

4.) The Import Log/Well window will now display the details of the file(s) to be imported. Select or click 
(highlight) the file(s) to be imported.  

Note: Use the  button to select all of the files or use the   button to select none of the files. 
Note that you can select or turnoff individual files by simply clicking on them with your mouse. The 

 button will remove the selected/highlighted files from the import list, but will not delete them. 

The  button, on the other hand, will completely erase the selected/highlighted files from their 
directory. Once deleted, these files will no longer be recoverable. 
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6.) Click on the  button to activate the following system message, “Do you really want to 
IMPORT the highlighted files?”. 

7.) Click on the  button to proceed with the import. 

Note: If you clicked on the  button, and the file you are importing contains the information 
from an Entire Well, the following system message will be activated, “About to IMPORT ENTIRE WELL 
data. All information associated with this well in the database will be OVERWRITTEN. Continue?”. 

9.) Click on the  button. 

10.) Upon completion of the import, the following system message will then be activated, “Data has been 
imported successfully.” 

11.) Click on the  button to confirm the successful import of the data. 
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Power*Suite V9.0 Program Removal 

Note: It is not necessary to remove Power*Suite V9.0. It can be done now or later. Also it doesn’t 
have to be done at all. 
 

1.)  Click on the Start menu selection, select Settings and select Control Panel. 

 

2.)  Click on the  Add or Remove Programs selection in the Control Panel Window. 

Note: Uninstall the Power*Suite V9 Updates first 

 

3.)  Click on the Power*Suite V9.0 program and click on the  button. 

4.)  This will activate an Add or Remove confirmation window. Click on the  button. 

 
5.)  This will remove the Power*Suite program. When it is finished it will remove Power*Suite form the list. 

Close the windows by clicking on the  x’s in the upper right corner of the windows. 

 


